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Many of us face a constant stream of information, 
shifting priorities, and increased workloads  
in our daily lives.   
Navigating these demands successfully requires executive function  
— a critical set of cognitive skills — which helps us plan, organize, and execute tasks.


While managing these demands can be overwhelming for everyone, they are  
especially challenging for the roughly 20% of the population who are neurodivergent.1 
Neurodivergence refers to natural variation in how brains work — including ADHD, 
autism, dyslexia, dyscalculia, dyspraxia, and other neurological differences. While 
neurodivergence is broad and diverse, many experience its significant impact on 
executive function.


Regardless of how we process information, we all use critical cognitive skills in our day-
to-day work and encounter executive functioning obstacles, whether that’s difficulty 
paying attention, getting started on a daunting task, or sifting through large amounts of 
information to make a decision.


This guide is a collaboration between Google Workspace and Understood.org.  
It’s designed to help everyone, especially those with thinking and learning differences, 
use Google Workspace with Gemini to help overcome executive functioning obstacles, 
do their best work, and achieve workplace success.

1 Diamond A. Executive functions. Annu Rev Psychol. 2013;64:135-68. doi: 10.1146/annurev-psych-113011-143750. Epub 2012 Sep 27. 
PMID: 23020641; PMCID: PMC4084861.
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Understanding executive  
functioning challenges

Executive functioning is a set of mental skills that includes working memory, flexible thinking, 
and self-control.2 Challenges arise when our brains struggle to manage priorities, stay 
focused, and organize tasks. They’re unrelated to general intelligence — you can be highly 
intelligent and still struggle to complete work tasks on time. 


Researchers have proposed several frameworks for executive function. For this guide,  
we're using Thomas E. Brown’s six-cluster model for its practical structure. It maps cognitive 
processes to the demands of everyday life tasks and work. While Brown developed it 
primarily from attention-deficit/hyperactivity disorder (ADHD) research, he highlights 
processes that are relevant to everyone. 


Brown’s model breaks down executive functioning into the following:

Activation  
Organizing and prioritizing workload  
and getting started on tasks even  
when you don’t feel motivated.

Focus  
Sustaining your attention on a task,  
shifting focus when necessary, and  
filtering out distractions.

Memory  
Holding information in mind to use it  
(working memory) and accessing what  
you’ve previously stored when you  
need it (recall).

Action  
Monitoring your own behavior  
(self-monitoring), controlling impulsive  
speech or actions, and adjusting course  
(self-regulation).

Effort  
Regulating alertness, sustaining  
effort, and processing speed.

Emotion  
Managing feelings of frustration, worry,  
or disappointment so they don’t derail  
you from your work.3

While the model defines executive function with six main clusters, we’ve broken them down 
further, so you can identify which areas are most relevant to you and how Workspace with  
Gemini can help.

2 Diamond A. Executive functions. Annu Rev Psychol. 2013;64:135-68. doi: 10.1146/annurev-psych-113011-143750.  
Epub 2012 Sep 27. PMID: 23020641; PMCID: PMC4084861.


3 Brown, T.E. ADD/ADHD and impaired executive function in clinical practice. Curr Atten Disord Rep 1, 37–41 (2009).  
https://doi.org/10.1007/s12618-009-0006-3 
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Activation

If you’ve ever stared at a blank page and had difficulty getting started, you’ve probably 
struggled with activation. When the activation piece of your executive function stalls,  
it can look like procrastination or a lack of motivation. 


Activation can be broken down into the following components:


Organizing 


Structuring your thoughts, tasks, and materials so the work feels manageable  
rather than overwhelming.


Prioritizing 


Sorting tasks by importance so your energy has a clear direction.


Getting started on a task 


Lowering the activation energy required to begin, especially when a project  
feels daunting or dull.

Focus

Focus helps you maintain momentum after starting a task. While technology has turned 
the workplace into a hyper-connected space, it has also created an environment full of 
digital noise, making it harder to sustain our attention on a single task or effectively shift 
focus when we need to. 


Focus can be broken down into the following components:


Sustaining attention


Keeping your focus on the task long enough to make meaningful progress.


Shifting focus between tasks  


Moving smoothly between different tasks as your priorities evolve throughout  
the day. This can include recognizing when deep concentration on one thing,  
sometimes called hyperfocus, is serving you as a strength, or when shifting focus  
would better serve your goals and values.


Filtering out distractions 


Directing your attention to what you intend to work on, even when other things  
are competing for it.
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Effort

Regulating your energy at work or knowing when to start, stop, or pace yourself, is a 
crucial skill that many find challenging. You might struggle with the effort part of Brown’s 
cluster if you get drowsy in long meetings, over-invest in minor details, or struggle to 
process large amounts of information efficiently. 


Effort can be broken down into the following components:


Regulating alertness 


Balancing your energy levels, such as staying awake during long meetings, dense  
reading, or tasks that aren’t intrinsically interesting. Also important for slowing  
the mind down when it’s time for rest.


Sustaining effort 


Maintaining the mental energy a task requires from start to finish.  
Even in that last 10%.


Processing speed 


Taking in new information at a speed that works for you in modes  
that you most prefer — whether that’s reading, seeing, listening, or doing.

Memory

Memory is the mental space that allows us to hold, retrieve, and use information at any 
given time. It helps us track past decisions, recall what’s relevant, and stay oriented  
in the present, but it’s difficult to remember information when we’re under pressure  
or distracted. 


Memory can be broken down into the following components: 


Working memory 


Holding information in mind and using it in the moment to finish the task at hand  
(i.e. remembering instructions just given to you).


Recalling information 


Accessing your stored knowledge and past experiences when you need them.
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Action

The action part of executive function is about moving from intention to execution in  
a deliberate manner. For many, working on this means learning to act thoughtfully  
rather than impulsively, helping to minimize regret and maximize outcomes aligned  
with our goals. 


Action can be broken down into the following: 


Self-monitoring 


Staying aware of how you are performing a task while doing it,  
catching your own mistakes, and noticing when you’ve drifted off-target. 


Self-regulating 


Adjusting course in response to what you notice — including controlling  
impulsive speech or actions, and slowing down when needed.

Emotion

Emotions are an essential part of the human experience, but for some of us, when a 
strong emotion arises, it takes over the entire operating system, making it hard to focus 
on little else. This can be true with both challenging feelings, like frustration with a 
colleague; and pleasant feelings, like excitement over a new project. 


Emotion can be broken down into the following:


Managing frustration 


Having the right tools to work on difficult feelings that take over (i.e. frustration,  
disappointment, and worry), so it doesn’t run your operating system. 


Acting with intention 


Choosing your response rather than letting the emotion be the core decider,  
so your words and actions stay aligned with your goals and values.

Your guide to using  
Google Workspace with Gemini

To help you get the most out of this guide, we’ve mapped Google Workspace with Gemini 
tips to each executive function cluster in Brown’s model. The strategies in this guide are 
anchored on Brown’s research and Google x Blink research on AI tools for neurodiverse 
users. Feel free to explore and dive into the tips that feel most useful to you. While most 
features mentioned in this guide are available to all users, it’s worth noting that some 
examples may require specific Google Workspace plans. 
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Find and synthesize

How Workspace with Gemini can help

Recall and connect context 

Supported cluster activities:

Organizing Prioritizing Getting started on a task Sustaining attention

Shifting focus between tasks Sustaining effort Processing speed

Working memory Recalling information

Navigating the digital landscape can feel like filtering out a thousand different frequencies all 
at once. This is where Workspace Intelligence, the contextual AI layer built into your 
Workspace apps, becomes a powerful ally for your unique working style. It’s a secure, 
dynamic system that processes patterns of complex relationships within the content in your 
Workspace apps (such as Docs, Slides, or Gmail), active projects, collaborators,  
and organization’s domain knowledge.


Whether it’s automatically summarizing long email threads to prevent information overload, 
suggesting relevant files before you have to search for them, or helping you organize and 
structure your thoughts, Workspace Intelligence can connect your context proactively to 
help lower your activation energy, help you stay focused, regulate your effort, and assist you 
in recalling information. For example, you can use Ask Gemini in Chat — your command line 
for work — to start your day with prioritized proactive briefings, find context by tracking 
down any email or file, and stay in flow by creating docs and slides right from Google Chat. 

Workspace Intelligence turns your scattered emails, chats, and files into a cohesive knowledge graph.
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Find and synthesize

Organize files to recall context

Supported cluster activities:

Organizing Getting started on a task Sustaining attention

Shifting focus between tasks Sustaining effort Working memory

Recalling information

Maintaining your focus, organizing your content, and recalling information is difficult if you’re  
constantly switching apps or looking for project updates across scattered information.  
Try using Drive projects to consolidate relevant files in one place, keeping your team and 
Gemini grounded on the right information. It reduces the mental friction of searching for 
context and equips Gemini with the exact information it needs to generate tailored drafts 
and insights, leaving you free to focus entirely on executing. 


To create a Drive project, open your Drive and navigate to New > New project, name your 
project, and add your sources.

Your sources (2)

Add arrow_drop_down

check_box Marketing Scope

check_box folder_mydrive Marketing Roadmap

keyboard_arrow_down Suggested

Add a source to be used for future responses.

Learn more

add

add

add

keyboard_arrow_right Source settings

Ask Gemini

home_storage 2

List the specific deliverables and deadlines 

requested in this folder for our Q4 marketing 

activities.

arrow_upward

Organize your team’s work in Drive projects to get AI overviews and track your progress.

Now, anytime you want to focus on the task at hand without digging through files,  
you can visit the Drive project you created to get the information you need. 
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Find and synthesize

Prepare for the day with daily briefings on your tasks

Supported cluster activities:

Organizing Prioritizing Getting started on a task Shifting focus between tasks

Sustaining effort Processing speed Working memory Recalling information

Instead of starting your day by digging for the right information and context, try using  
Ask Gemini in Chat to get a daily briefing on your action items. It compiles key action items 
and pending tasks you might have missed across your Workspace apps into a daily brief 
that’s sent directly to your Google Chat.


You can enable a daily briefing by navigating to Ask Gemini in Chat and typing /settings  
in the prompt bar, and turning on daily brief settings. 

Active keyboard_arrow_down help settings apps

Ask Gemini history folder

home
alternate_email
star

Ask Gemini
Ask Gemini

12:55Claude responded: I've analyzed the roadmap from the meeting, and the 
critical milestone is the Project Atlas Beta launch on April 1st.I've analyzed the 
roadmap from the meeting, and the critical milestone is the Project Atlas Beta 
launch on April 1st. That timeline is statistically ambitious, but I've calculated a high 
probability of success if we stick to the core requirements! I've already pinned the 
new dates to the channel so they don't get lost in the shuffle. Ping me if you need 
help reorganizing your calendars to make space for the work.

You

Summarize the key decisions from last week on Project Atlas

add arrow_drop_down send

Ask Gemini in Chat helps you prioritize your day, and can use skills to manage tasks on your behalf.
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Find and synthesize

While the daily briefing is one great way to start your morning,  
Ask Gemini in Chat can also help you manage your workload  
throughout the day by:

01 Finding and synthesizing information


Find specific information, messages, emails, or files across  
your connected workspace


Synthesize key decisions, notes, and updates from across different sources

02 Prioritizing jobs for the day


Highlight your daily tasks and priorities


Help you catch up on unread messages and emails


Help you catch up on specific topics and spaces

03 Getting things done


Draft emails and messages


Schedule and manage meetings


Generate multimedia including presentations, images,  
and podcast-style overviews
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Find and synthesize

Structure information and organize your thoughts

Supported cluster activities:

Organizing Getting started on a task Sustaining effort Processing speed

If you need help organizing information or your thoughts in a structured manner, you can ask 
Gemini in Docs to create structured templates for recurring tasks such as project plans, 
meeting agendas, or summary decks to reduce the activation energy needed to organize 
your thoughts in the first place. 


To create a Google Doc from a template, navigate to File > New > From template gallery or 
select File > New > Help me create, select the “Templates” chip from the bottom bar of 
your new page, and choose the template that fits your use case. 

Template gallery

Project proposal
Tropic

Project proposal
Spearmint

Project proposal
Geometric

Meeting notes
Tropic

Meeting notes
Modern writer

Create structured templates by using built-in templates in Docs.

You can also organize information in Google Sheets by letting Gemini build and edit 
spreadsheets agentically. Gemini in Sheets will pull insights from your work and the web, 
manage cell formatting, and help you analyze faster with auto-generated pivot tables and 
charts. Soon, skills in Workspace Studio will also allow you to create and share templated 
documents with agentic automation for repetitive tasks. 
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Find and synthesize

Make sense of information in multiple formats

Supported cluster activities:

Organizing Sustaining attention Regulating alertness Sustaining effort

Processing speed Working memory Recalling information

NotebookLM can act as an AI-powered assistant to help you summarize, analyze, and 
synthesize information from various sources. You can upload documents, web pages, videos, 
and more, and ask questions or generate summaries based on the sources you provide. 
Think of it as a personalized AI research assistant that helps you make sense of information 
in multiple formats.

Audio processing

If you prefer to process information by listening, NotebookLM can turn long, text-heavy 
PDFs into a conversational, podcast-style audio summary that you can listen to while 
you’re on the go.


To create an audio podcast in NotebookLM, create a new notebook, upload your sources, 
and open the control panel to find audio overviews. Similarly, you can also hear audio 
summaries of a Google Doc or just a tab by selecting Tools > Audio > Listen to this Tab 
or Listen to Document Summary in Docs.

Quarterly wrap-up 

Sources dock_to_right

add Add source

Select all sources check_box Audio Overview
article

graphic_eq

drive_presentation

Drive_pdf

docs

docs

web

Q4 Financials check_box

All-staff recording check_box

Sales pitch deck check_box

Customer testimonials check_box

Market research check_box

Product roadmap check_box

Quick-start guide check_box

ideo Overview

Mind map

First dra

rien doc

Create audio overviews from your notes, videos, copied text, and more.
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Find and synthesize

Visual processing

If you’re a visual learner, infographics in Google Docs and mind maps in NotebookLM are 
incredibly effective at bringing structure to scattered thoughts. In a Doc, try using Gemini 
to generate images and infographics based on your document’s content. 

Generate an image close

Aspect ratio

Square 1:1

Landscape 16:9

Portrait 9:16

An image that deconstructs a tangerine layer by layer

1:1 palette arrow_upward

Gemini in Docs can now generate images to match your content, and refine your document based on comments.

In NotebookLM, try generating interactive visual diagrams (mind maps) to help you grasp the 
overall structure of your sources. Mind maps also allow you to zoom in on specific areas and 
click concepts to get summaries and start a chat on a topic. Like audio overviews in 
NotebookLM, mind maps can be found in the NotebookLM control panel. 

Ask Gemini

page_info

Recent

Tools
Add notebook Report: Large Language Models

2 hosts

Pro

Studio chevron_right Audio Overview

info download

Report: Large Language Models

1 sources    Created January 05, 2026

Audio Overview

pause_circle 👋  Join refresh

Infographic

Grasp the overall structure of your sources and connect seemingly unrelated concepts with mind maps in NotebookLM.
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Create and refine

Brainstorm ideas and breakdown tasks with Gemini

Supported cluster activities:

Getting started on a task Sustaining attention Shifting focus between tasks

Sustaining effort Processing speed Working memory

Recalling information

Try starting your next big project by giving the Gemini app the context  
and materials it needs to help you brainstorm and organize your workload. 


To turn Gemini into a personalized brainstorming partner, you’ll want to:

01 Set the stage

Outline your primary objectives, your target audience, and any specific limits on time 
or budget.

02

03

04

Provide the materials

Upload your research, rough notes, or documents so Gemini can quickly get up  
to speed.

Collaborate and ideate

Use Gemini to uncover fresh perspectives, identify potential challenges, and round out 
your initial concepts. 

Create an action plan

Ask Gemini to translate your overarching goals into a clear timeline featuring specific 
milestones and easy-to-tackle tasks, and export the outputs into a Google Doc. 

Every task is unique, but you can follow the steps above as a starting point  
to get the most effective results from Gemini. 
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Create and refine

Overcome the blank page with generated first drafts

Supported cluster activities:

Organizing Getting started on a task Sustaining attention Sustaining effort

Processing speed Working memory Recalling information

Sometimes the hardest part of starting a project is the manual prep work, gathering notes, 
and digging through emails just to get a first draft on the page. Workspace Intelligence 
retrieves relevant emails, chats, files, and information from the web, to help turn your ideas 
into fully formatted drafts using your voice, brand, style, and company templates. This can 
help shift the cognitive workload from the heavy lifting of creating from scratch to editing 
and refining. 

Overcome blank page syndrome by drafting, editing, or refining entire documents with 
Gemini in Docs or Help me create. You can get started by prompting Gemini in the 
bottom bar of your Google Doc or use Help me create by selecting File > New > Help 
me create. Type in a detailed prompt describing what you want to build, add any relevant 
documents for Gemini to reference, and create. Gemini will generate the formatted 
content directly onto the page to help you get started. 

      Creating drafts in Docs

Generate an image

A portrait of a 
serious man 
against a teal 
background who 
has a bunch of 
bananas on his he...

Reuse prompt

close

Light and airy modern kitchen design with a waterfall island.

aspect_ratio palette

Gemini in Docs can generate images to match your content, and refine your document based on comments.
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Create and refine

       Creating presentations in Slides

Creating great presentations usually means crafting a compelling story and beautiful slide 
designs, but creating these slides from scratch can take a lot of time and effort. Instead,  
try asking Gemini to create editable slides or full presentations with a prompt in Google 
Slides. Gemini in Slides will automatically craft the messaging, create layouts, manage  
the formatting, and match the style of your other slides to reduce the amount of effort  
it takes to brainstorm and format your slides from scratch. 

comment Slideshow

his is a large title with a comment insidehis is a large title with a comment insidehis is a large title with a comment insidehis is a large title with a comment insidehis is a large title with a comment insidehis is a large title with a comment insidehis is a large title with a comment insidehis is a large title with a comment insidehis is a large title with a comment insidehis is a large title with a comment insidehis is a large title with a comment inside
add

1

search undo redo print imagesearch_roller zoom_in Fit arrow_drop_down arrow_selector_tool add_comment keyboard_arrow_uparrow_drop_down
his is a large title with a comment inside

2

Juan Ferreira 
3

4

Lori Cole

Create fully editable presentations in Slides.

       Creating spreadsheets in Sheets

In Google Sheets, you can build or edit spreadsheets using natural language to describe 
what you need. Gemini in Sheets will gather data across your files, emails, chat, and the web 
to create a structured spreadsheet complete with charts and graphs.
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Create and refine

Use voice input when typing feels overwhelming

Supported cluster activities:

Regulating alertness Sustaining effort Processing speed Working memory

Recalling information

Sometimes the hardest part of the job at hand isn’t having the ideas — it’s getting them from 
your brain onto the screen. This is where voice typing in Google Docs comes in handy. Think 
of it as a shortcut that bypasses the effort of spelling, grammar, and typing. To find voice 
typing in Docs, navigate to Tools > Voice typing. If you just want to chat with Gemini, look 
for the microphone icon next to where you’d normally prompt Gemini. With voice input,  
you can just share what’s on your mind and bypass the typing to get your thoughts  
on paper quickly.

Voice typing

undosearch

100% arrow_drop_down

100% arrow_drop_down 15 add_comment

Share

English (UK)

Ask Gemini

Thinking keyboard_arrow_down mic

Use voice typing to capture your ideas without needing the keyboard.
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Execute on projects and align stakeholders

Focus and reorient on what you need to know and do 

Supported cluster activities:

Organizing Prioritizing Shifting focus between tasks Filtering out distractions

Sustaining effort Processing speed Working memory Recalling information

Your email inbox can quickly overflow with information, deadlines, and requests requiring 
your attention. Gemini can help you stay focused by surfacing the most helpful information 
and to-dos in one place with AI Overviews, and, soon, AI Inbox in Gmail. Gemini 
synthesizes information from various email threads to create a concise summary of key 
points directly in one place, so you can quickly reorient yourself without manually digging.


AI Overviews are built into Gmail to deliver personalized search results. Instead of looking 
for an email that’s been buried over time, you can ask AI Overviews to help you find the 
answer you’re digging for. Use AI Overviews by typing in the search bar of your Gmail. 

il When is the next scheduled project briefing?

AI Overview

T he briefing is scheduled for tomorrow at 1:00 PM in the West Conference 

Room (and via Google Meet).

M aria and Amy have accepted the invite; Amanda is tentative but has shared 

her update in the project doc.

AI Overviews in Gmail lets you ask your inbox anything with natural language.

You'll be able to find your AI Inbox on the left hand side of your Gmail under the inbox tab. It 
will suggest the latest to-dos, topic summaries, and updates based on your field of work and 
link the sources it's pulling information from.
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Execute on projects and align stakeholders

AI Inbox

Hi Stephen 👋 You have 3 suggested to-dos.

Suggested to-dos

Approve Q3 budget

Review QBR presentation

Respond to lunch invitation

AI Inbox in Gmail makes it easier to find what matters in emails and files.
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Execute on projects and align stakeholders

Automate and streamline tasks across your apps

Supported cluster activities:

Organizing Prioritizing Getting started on a task Sustaining attention

Shifting focus between tasks Filtering out distractions Regulating alertness

Sustaining effort Processing speed Working memory Recalling information

You can automate your work with Gemini in Workspace Studio. Workspace Studio  
is a low-code/no-code automation tool that allows you to build custom flows to automate 
tasks. Create flows to manage tasks, organize your work, surface timely information, send 
communications, and more. It all helps to reduce the activation energy and effort in your 
daily work. There are several ways to create automated workflows in Workspace Studio, but if 
building a workflow from scratch feels overwhelming, you can also describe what you need 
to Gemini or jump-start the process by using one of the available templates. 

Create flows easily with Workspace Studio’s built-in templates.

Soon, you’ll also be able to generate skills in Workspace Studio, which allow you to offload 
repetitive tasks to AI, and apply them anywhere you use Gemini in Workspace. 
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Execute on projects and align stakeholders

Simplify scheduling, rescheduling, and meeting creation

Supported cluster activities:

Organizing Prioritizing Sustaining effort

Gemini in Calendar can lower the activation energy and effort needed to organize meeting 
logistics. Offload analyzing everyone’s availability, time zones, and working hours to Gemini 
so it can identify the best time slots for you. If multiple attendees decline your invite and you 
need to reschedule, Gemini will show you a banner of suggested times, so you can easily 
update the invite rather than re-analyzing calendars yourself. 

T U E W E D T H U F R I

2321 22 24

Follow up
8:30 AM

Order stationary, 8 AM

Finalize presentation, 10:30 AM

Email John, 11 AM Call store, 11 AM

Wed, 22 Sep  ·  11:00 - 12:00 pm

You Marion Beauchêne

View schedules

Submit reimbursement, 9 AM

Focus time
8 – 10 AM

Project Clover Briefing

Save

Lunch with Lucy
12 PM

Presentation
11:30 AM – 1:30 PM

Use Gemini in Calendar to help you schedule and reschedule your meetings.

Gemini can also help you organize your “to-do” lists. Instead of manually organizing your 
schedule, give Gemini your “to-do” list and let it handle the logistics for you. For example:

Ask Gemini in Chat or Gmail: 


“I need to finish a 3 hour research paper, book a Friday afternoon dentist 
appointment, and hit the gym twice. Help me organize my schedule  
and add it to my calendar.”

Gemini will sync with your Google Calendar to find the best slots to schedule your events. 
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Execute on projects and align stakeholders

Add to Calendar

I created an event called "Board Meeting" on 
Tuesday, May 12th at 2:30 pm.

Calendar

Board Meeting
Tue, May 12 · 2:30 pm - 3:30 pm edit

Use Gemini in Calendar to help you organize your day.

Finally, adding meeting invites to your calendar can be time consuming and take time and 
effort away from higher priority tasks. To quickly add events to your Google Calendar from 
your Gmail or Google Chat, look for the Add to Calendar feature in Gmail or Chat. 
Additionally, right in the flow of work, Gemini in Chat will proactively recognize when a 
meeting may be needed; you can use Ask Gemini in Chat to help you schedule and manage 
meetings. 
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Execute on projects and align stakeholders

Take notes in meetings  
and break down meeting transcripts

Supported cluster activities:

Organizing Prioritizing Sustaining attention Sustaining effort

Processing speed Working memory Recalling information

Active participation and notetaking during meetings are competing tasks that split your 
attention and drain your focus. To fully focus on the conversation, hand off notetaking  
to Gemini with Take notes for me in Google Meet for any meeting — in-person  
or virtual. Gemini will email you meeting notes with takeaways and action items for you to 
review after your meeting. 


To enable Take notes for me and transcripts in Meet, look for the pen icon with the Gemini 
logo next to it and select the also start transcription checkbox to get a complete record  
of the meeting delivered straight to your Gmail. 

Gemini is taking notes

Stop taking notes Notes from “Execution Plan”

Open meeting notes

attachment Notes by Gemini

Get a full recap of your meeting with Take notes for me in Meet.
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Execute on projects and align stakeholders

Protect your focus time

Supported cluster activities:

Organizing Prioritizing Getting started on a task Sustaining attention

Shifting focus between tasks Filtering out distractions

Protect your attention and filter out digital noise by enabling clear boundaries across your 
Workspace apps. For example, silence distractions by turning on “Do not disturb” in Gmail 
and Google Chat, and protect your schedule by blocking out “Focus Time” on your Google 
Calendar. 


You can also intentionally block out time on your calendar to create starting and stopping 
points for each of your tasks. When creating these time blocks, add a short summary of the 
task or any relevant attachments to the event block as another way to help you quickly 
reorient and regain context of the task before starting.

25



Communicate and collaborate intentionally

Proactively proofread your emails before sending

Supported cluster activities:

Sustaining effort Self-monitoring Self-regulating

If you’re drafting an email and need a second pair of eyes to polish your message, try using 
proactive proofreading in Gmail. Gemini helps take away the effort from proofreading by 
automatically providing suggestions on conciseness, active voice, sentence structure, 
grammar, spelling, word choice, and more.

Project Alpha status update

Hi Team,



I just received the latest status update regarding Project Alpha. Sarah and I  

reviewed the initial draft this morning, and overall, the feedback we gathered seems 

good. The research team completed the preliminary market analysis earlier today.   

Looking ahead, in order to keep the project on track for the Q3 deadline, we need  

to consolidate the feedback from all stakeholders, integrate the new market data, and 

finalize the strategy document by the end of next week, which will ensure we have 

sufficient time for review cycles before the final presentation.



Best regards,


Ann
To meet the Q3 deadline and allow time for reviews, we 

must consolidate feedback and market data into a 

finalized strategy document by the end of next week.

Make more concise feedback cancel

Send

Polish your email drafts with Proofread before sending.

If you've drafted an email but want to avoid sending a message during off-hours, try using 
the Schedule send feature in Gmail. And for those moments when you need a re-do, 
enabling the 30-second Undo send delay in Gmail acts as a safety net, allowing you to catch 
typos or rethink a message immediately after hitting send. You can enable Undo send and 
customize the cancellation period in the general settings of your Gmail.
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Communicate and collaborate intentionally

Prepare your thoughts and tone before acting

Supported cluster activities:

Self-monitoring Self-regulating Managing frustration Acting with intention

Hand raising in Google Meet provides a deliberate, low-pressure way to join the 
conversation. It’s a helpful tool if you prefer to gather your thoughts first or find it 
challenging to interrupt a high-speed meeting. It supports working with impulsivity, 
encouraging you to wait your turn, giving you the space to gather your thoughts, and 
listening fully before contributing. 

Look for the hand symbol on the Google Meet bar to hand raise during meetings.

Gemini can also serve as a valuable sounding board for tone. However, it’s important to view 
Gemini as a second perspective rather than a final verdict on your message. Many 
neurodivergent individuals face constant pressure to “soften” or mask their natural 
communication style; use this tool to explore alternatives, but remember, you know your 
relationships and context best.


With that in mind, let’s say you want to get another perspective on tone before sending an 
email, chat, or entering a meeting. Try explaining your situation to Gemini and include 
relevant email threads, documents, and chat conversations. Then ask Gemini to temperature 
check your tone based on the context it was provided. For example:

Ask Gemini in Chat: 


”I’m feeling a bit frustrated. How does this response read? Does my frustration 
come through too much?”

Similarly, you can use Gemini to interpret a coworker’s message. For example, if you’re 
confused by the compliment sandwich or are having a hard time understanding indirect 
messages, try asking Gemini:

Ask Gemini in Chat: 


“I’m having a hard time understanding what my colleague is trying to tell me.  
Can you please make it more brief and direct? What are the key points?” 

Again, while Gemini will provide contextual responses to help you gut check tone and 
meaning, use its feedback to inform your choices rather than dictate them. 
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Communicate and collaborate intentionally

Build confidence before going into difficult situations

Supported cluster activities:

Organizing Self-monitoring Self-regulating Managing frustration

Acting with intention

If you need help navigating a difficult conversation, ask the Gemini app itself to help organize 
your thoughts and express them in a way that effectively reflects your goals and intent. 
Whether you’re preparing to explain a project delay, practicing for a performance 
assessment, or providing feedback on a critical project, Gemini can suggest different ways of 
presenting your ideas. 


We’ve included a few prompts for scenarios that might not necessarily apply to everyone, 
but they give you an idea of how you can ask the Gemini app to help you prepare for difficult 
conversations.


In the Gemini app:

”Help me practice framing this project delay to leadership.”

”Can you provide a few examples on how to make this feedback  
sound less critical and more constructive?”

”Here is a rough list of my achievements this quarter, can you help me prepare  
a draft for my performance self-assessment?”

Another way of lowering the stakes and helping you feel confident in your ideas  
in a high-pressure situation is to stress-test your ideas with Gemini before the real deal.  
By asking Gemini to play devil’s advocate or simulate a skeptical audience, you can  
stress-test your ideas in a safe, controlled environment. Then you can identify potential  
blind spots, refine your logic, or rehearse your responses to tough questions before  
they’re asked, helping you feel more confident and prepared going into the conversation. 
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Conclusion

This guide explores how Google Workspace with Gemini can act as a powerful assistant in 
navigating the complexities of the modern workplace, especially for those who struggle with 
managing executive functioning challenges. By using features that support the various 
components of Thomas E. Brown’s six cluster model, you can create a work environment that 
supports your unique needs. We encourage you to experiment with any combination of these 
strategies to learn how Workspace with Gemini can help you unlock your best work. 
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